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Publishing maps on the Internet 
presents today’s cartographers 
with a new set of challenges. The 
Internet allows anyone, anywhere, 
anytime to view maps. Cartogra-
phers must now decide how to 
make them available, which format 
to use, which technology, and what 
map reading features to include. 

The most basic issue that im-
pacts the effectiveness of maps on 
the computer is display resolution. 
A screen’s display resolution for 
today’s computers ranges between 
72 and 96 pixels per inch, while 
modern maps are printed using 
many times that resolution. It is as 
if cartography is stepping back into 
the days of wood-block prints. This 
loss of resolution can be mitigated 
using several techniques. 

Today, many of the maps on the 
Internet are static. They are low-
resolution images with poor data-
ink (colored pixels) ratios. Better 
techniques must be used to increase 
the computer screen’s ability to 
convey cartographic information. 
These techniques yield maps that 
are more interactive or animated, 
in other words, more informative. 
Users can query and explore maps; 
movement and sound can also be 
introduced to reinforce the user’s 
experiences. To provide this sort 
of rich content, cartographers will 
need to use the right tools to make 
and publish their map. One such 
tool is Macromedia Director. This 
article will focus on techniques for 
creating rich map content for the 
Internet using Director.

Macromedia Director

Macromedia Director is a raster-
based multimedia presentation 
tool distantly akin to Microsoft’s 
Power-Point or the old Apple Hy-
perCard environment. Historically 
Director was targeted towards the 
creation of kiosk presentations 
and interactive CD-ROMs but 
over the past few years it has been 
revamped for the web. 

Once a project has been cre-
ated in Director, it can be saved 
as a Shockwave movie that can 
be played by a plug-in for web 
browser such as Netscape Navi-
gator or Internet Explorer. Most 
modern computers now have these 
plug-ins installed by default and 
Macromedia estimates that 65% 
of Internet users have it enabled 
(December 2001).

Example Project: Annual Precipi-
tation in California

The following project, which 
contains several maps are taken 
from a recent NACIS Web Map-
ping Contest entry. This project 
was completed at Humboldt State 
University with the assistance 
of Dr. Margaret Pierce during an 
Advanced Cartography semester 
in 2000. You can view and should 
refer to this project and its source 
files while reading this article at: 
www.nacis.org/contest.html

The project has an interactive, 
animated, and sound-enhanced 
interface detailing recent precipita-
tion data for the state of California. 
The maps were designed in Adobe 
Illustrator and then exported to 
Macromedia Director for composi-
tion and sequencing.

Director Basics

While Director provides a useful 
environment for arranging and se-
quencing is not useful for creating 
or designing map or interface con-
tent. The program can, however, 
import most raster image formats 

including GIF and JPEG, which are 
the most commonly used formats 
for the web. For Adobe users, 
versions 9 and 10 of Illustrator 
now include ImageReady, which 
is quite handy for optimizing web 
graphics.

When images are imported 
into Director they become cast 
members, available to use within 
Director’s layout and sequencing 
environment. Director is modeled 
after the Hollywood format of 
movie production. Each movie has 
a cast of characters called “sprites”, 
is orchestrated with a “time line” 
and takes place on a “stage.” 

Adding Motion to the Display

It is important to create a user 
experience where the map elements 
are clearly arranged and logical in-
teraction is not only facilitated but 
also encouraged. For cartographers, 
thinking of a map or maps in terms 
of potential sequential experiences 
is new, but hardly foreign. Director 
provides a useful architecture for 
defining navigation and interaction 
parallel to the display of the maps. 

Director uses a timeline meta-
phor for arranging action on the 
stage. The timeline consists of a 
sequence of frames in which any 
of several channels (similar to the 
layers found in cartographic design 
packages) exist. These channels can 
have their visibility toggled on and 
off in any frame. [Figure 1] 

The timeline allows a movie to 
be planned out in a linear progres-
sion, left to right. However, a movie 
need not be set for linear viewing; 
a frame or group of frames can act 
independently of the other frames 
allowing the movie to be manipu-
lated by the viewer as it plays. It 
may be helpful to conceptualize 
each section of the movie as the 
chapters found on a DVD.

Director is useful for animating 
sequences of maps. Each map can 
be placed in a frame and Director 
will play through a series of frames 
until a “stop on frame” com-
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Figure 1. The score shows the movie is currently on Frame 37, Channel 1 has the map for 1985 dis-
played, Channel 2 has the user-interface navigation bar displayed, and Channel 3 contains the anima-
tion controls (pause, backwards, forwards). The top portion of the score window displays information 
about the selected object; where it is positioned on the stage and how long it is on the stage (1984 is on 
the stage in Frames 29 through 38). 

Figure 2. This script is associated with a specific frame and is accessed via Modify > Frame > Script. 
The script is called when the movie plays through that frame (exits the frame) and keeps the movie on 
that frame (keeps cycling through that frame).

Figure 3. This script is run when the user releases their mouse button on the movie button. The in-
struction is for the movie to go to the frame marked by the “1984” label and start playing there.

mand is encountered [Figure 2]. 
The movie can jump to a different 
series of frames while playing and 
the content of those frames can be 
changed on the fly with more ad-
vanced programming techniques. 

These techniques were used 
when constructing the sample 
project. The maps representing 
each water year were placed in 
separate frames. The map presen-
tation’s interface allows the user to 

step through the maps one-by-one 
or in an animated series. 

Because of Director’s timeline, 
the program is well suited for map-
ping projects that emphasis motion 
or change in the dimensions of 
time and space. It is also useful for 
orchestrating interactivity.

Designing a Button

Version 8 of Macromedia Director 
does not anti-alias text. Therefore, 
use a graphics package or other soft-
ware that can produce a professional 
appearance. Export this interface 
element just like the map images.

Procedure:
1.	 Create a button in your pre-

ferred graphics software pack-
age.

2.	 Export the button as a raster 
image. (File > Export, File Type: 
JPG or GIF)

3.	 Import the image into the 
Director Cast as a Sprite. (File > 
Import)

4.	 Place on Stage by dragging the 
Sprite from the cast to the Stage.

5.	 Set up a Script for the button; for 
example, go to Frame Num-
ber or Marker in the timeline 
[Figure 3]. (Modify > Sprite > 
Script)

Introducing Sound

Sound can provide feedback for 
data exploration, provide back-
ground music, be a confirmation 
soundtrack for actions undertaken 
(button clicked > sound of bell 
rung), or provide narration.

Introducing voice-overs can 
serve to grab the user’s atten-
tion and this narrative technique 
can hold the visuals together and 
provide the viewer with an expla-
nation of what they are seeing, as 
they see it. These words must be 
planned and integrated with the 
map presentation before recording 
the voice-over. 

There are many different types 
of voices; some sound warm, 
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Figure 4. Examples of feedback user interfaces. 
When using the first, try to keep your voice in 
the middle, with peaks in the orange and valleys 
near, but not at the left edge.  The second shows 
the volume wave form—this example is good 
because it has a range of peaks and valleys, i.e., 
a dynamic engaging set of voice content—hope-
fully the map is equally dynamic and engaging.

others cold. A voice can make the 
listener edgy or make them feel at 
home. When recording narration 
voice-overs it is important to select 
an appropriate tone of voice for the 
material at hand.  

Record the voice-over in a quite 
room and use your recording soft-
ware’s feedback facilities.  Figure 4 
shows two kinds of interfaces for 
letting you know to speak up or 
back away from the microphone.

Digital sound can be recorded 
with a modern computer using 
programs like Peak LE for the Mac 
or SoundForge XP for Windows 
(those programs are included with 
Director). Once they are digitized, 
save them in a format compatible 
with Director (WAV, AVI, sound, 
or Quicktime at 22,050Hz, 16-bit, 
and mono) and import them into 
your cast (File > Import). The 
sound (now a sprite) can now be 
placed into your timeline to oc-
cupy a frame in one of the two 
sound channels. As the movie plays 
through the score it will automati-

cally play any sound clip found in a 
frame. For instance, in the example 
project voice-over narration is used 
to audibly introduce each section of 
the animation. 

Director’s ability to integrate 
sound into the map presentation 
allows cartographers to make use 
of several senses to deliver more 
information to the user. The voice-
over technique allows the user to 
interpret the map animation in real-
time as the movie plays and the 
narrator gives viewing pointers. 

John Krygier provides basic 
terms and concepts for using 
“Sound and Geographic Visualiza-
tion” in the volume Visualization in 
Modern Cartography edited by Alan 
MacEachrn (1994). At the recent 
NACIS 2001 meeting in Portland, 
Oregon the father & son team of 
Keith and Steven Rice (University 
of Wisconsin at Stony Point) pre-
sented the first of their three papers, 
“Scoring and Scripting Music for 
Animated Maps,” on using sound 
in cartographic products and their 
next two are highly anticipated.

Publishing to the Web with Direc-
tor

To publish your Director project to 
the Web it needs to be saved as a 
Shockwave Movie. 
1.	 Preview your movie (File > 

Preview)
2.	 Export your finished movie (File 

> Save as Shockwave Movie)
Once the movie is exported 

and copied to a location on a web 
server it can be linked to a normal 
HTML web page that introduces 
the movie, its topic, and viewing 
requirements (plug-in information).

Conclusion

Macromedia Director is just one 
way of creating content-rich Inter-
net maps. The learning curve for 
Director is moderate to steep so 
keep your map presentation simple 
and do as much of the map design 
in a graphics package. 

There are other tools for creat-
ing Internet compatible maps. For 
in-stance, Macromedia’s Flash 
pro-duct enables vector graph-
ics to be used. If you want users 
of your map to be able to print at 
high resolution then Flash is a good 
alternative.

A relatively new format for web 
vectors is the World Wide Web 
Consortium’s SVG or Scalable 
Vector Graphics format. Carto.net, 
based in Switzerland, has online 
tutorials and information on this 
emerging technology: http://www.
carto.net/papers/svg.

In general, if you want high 
quality printed maps, use a vec-
tor-based format such as SVG or 
Flash. If you only need high quality 
on-screen maps use Director or 
tradi-tional HTML. 

Content-rich maps on the Web 
have the potential for negative side 
effects. Often these content-rich 
maps require more bandwidth and 
modern multimedia capable com-
puters with specialized software for 
viewing and getting information 
from the maps.  

Modern cartography can em-
brace this change in medium using 
new delivery techniques that meet 
the demands of increasingly multi-
media literate and expectant map 
users. The opportunities that these 
new Internet-based technologies 
bring are well worth the effort.

Nathaniel Vaughn Kelso is a senior in 
Geography at Humboldt State Univer-
sity in northern California. He will be 
an intern with the National Geographic 
Society this summer in Washington 
DC. He can be reached by email at 
[nvk2@humboldt.edu].
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The Grammar of Graphics

By Leland Wilkinson
New York: Springer-Verlag, 1999.  
ISBN 0-387-98774-6, hardcover, 
$69.95, xvii, 408 pp., tables, 248 
illustrations (169 full color), refer-
ences, index.  

Reviewed by Russell S. Kirby, PhD, 
MS, FACE
University of Wisconsin-Madison

Some books defy simple classifica-
tion.  This volume is at once a text 
and a philosophical treatise, and 
to some may seem to be an adver-
tisement for a companion statisti-
cal software program.  Moreover, 
given its title, many cartographers 
and geographers might miss its 
considerable relevance to their 
work.  That would be unfortunate, 
for there is much of interest to be 
found within its pages.

The book’s title at once promises 
more and less than the text deliv-
ers.  Leland Wilkinson, the book’s 
author, is a legendary figure in the 
field of statistical software, having 
been an academic, a program-
mer, and an entrepreneur who 
wrote and marketed the SYSTAT 
program and is now senior vice 

president for SYSTAT products at 
SPSS, Inc.  Wilkinson has spent an 
entire career thinking about how 
to array, visualize, analyze, and 
interpret data, and this book sum-
marizes his current thinking on the 
subject.  While much of his work 
may seem theoretical, Wilkinson is 
a very practical man who has also 
developed a data graphics soft-
ware package designed around the 
grammar described here.

The heart of this book is a series 
of chapters describing the con-
cepts and structure of Wilkinson’s 
understanding of the grammar of 
graphics.  The grammar consists 
of verbs, nouns, and adjectives, 
and processes from the input 
noun “data” through the succes-
sive steps “dataset,” “varset,” 
and “graph,” to the output noun 
“graphic.”  Along the way, the 
verbs “dataview,” “varmap,” 
“grapher,” and “aesthetic” trans-
form the data as it is shaped into 
a graphic, modified by the adjec-
tives “reference,” “algebra,” and 
“coordinate.”  Each of these steps 
and modifications is described 
in general terms in a series of ten 
chapters, with illustrations of 
the application of most concepts 
discussed.  Cartographic examples 
appear throughout, although 
Wilkinson takes pains to remind 
the reader that his grammar does 
not create or emulate a geographic 
information system. 

Wilkinson’s purpose is to iden-
tify the general rules that govern 
the creation and presentation of 
data graphics, and to set forward 
a structure within which these 
rules might be operationalized 
most efficiently.  If the grammar 
is successful, it should be possible 
to reduce any data visualization 
problem into a graphic utilizing 
the rules outlined.  Wilkinson is 
the first to admit that this structure 
is only one of many that might be 
constructed while following these 
rules, and that the purpose of the 
book is to further the scientific un-
derstanding of the display of quan-

titative data in graphical forms.   
To this end, Wilkinson builds on, 
and in some instance criticizes, the 
work of Tufte, MacEachren, Bertin, 
Cleveland, Tobler, and many oth-
ers who have contributed to this 
field over the past fifty years. 

The final chapter pulls to-
gether the elements of the gram-
mar of graphics by attempting to 
graph complex problems solely 
through the rules proposed.  To 
demonstrate the versatility of his 
grammar of graphics, Wilkinson 
shows how it might be applied 
to generate a replica of Minard’s 
well-publicized “Figurative map of 
the successive losses of men in the 
French army during the Russian 
campaign, 1812-13” (Tufte 1983), 
and a complex dataset concerning 
the annual northward migration of 
the Monarch butterfly across North 
America.  

Among its many strengths, 
this book is very methodical, at 
times obsessively so.  It is also 
very well illustrated, with numer-
ous charts and graphics, a lengthy 
and comprehensive bibliography 
and index.  For this reviewer, 
the most significant weakness is 
that it is difficult to grasp many 
of the nuances of the proposed 
grammar without the opportu-
nity for a hands-on experience.  A 
companion CD-ROM including 
the examples in the book, so that 
readers can experiment with the 
various functions and elements of 
the grammar of graphics, would 
greatly enhance the text.  

This book is not for the faint 
of heart, and certainly not for the 
novice reader.  It would not be 
recommended reading for those 
without several courses in statis-
tics; geographers who lack training 
in cartographic methods may also 
find the book difficult.  However, 
those who read the book cover 
to cover and take some time to 
ponder the concepts and proposed 
theoretical structure for data 
graphics will find the experience 
worthwhile.  All geography and 


